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Abstract

These Application Notes describe the steps for configuring Avaya IP Office Release 10 with
the AT&T IP Toll Free service using AVPN or MIS/PNT transport connections.

The AT&T IP Toll Free service is a managed Voice over IP (VolP) communications solution
providing toll-free services over SIP trunks for business customers.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

AT&T is a member of the Avaya DevConnect Service Provider program. Information in these
Application Notes has been obtained through DevConnect compliance testing and additional
technical discussions. Testing was conducted via the DevConnect Program at the Avaya
Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the steps for configuring Avaya IP Office R10 with the
AT&T IP Toll Free service using AVPN or MIS/PNT transport connections.

Avaya IP Office is a versatile communications solution that combines the reliability and ease
of a traditional telephony system with the applications and advantages of an IP telephony
solution. This converged communications solution can help businesses reduce costs, increase
productivity, and improve customer service

The AT&T IP Toll Free service is a managed Voice over IP (VolP) communications solution
providing toll-free services over SIP trunks for business customers. The AT&T Toll Free
service utilizes AVPN' or MIS/PNT? transport services.

Note — The AT&T IP Toll Free service will be referred to as IPTF in the remainder of this
document.

Note — The solution described in these application notes also applies to the AT&T Business in
a Box service.

2. General Test Approach and Test Results

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members.
The jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces
pertinent to the interoperability of the tested products and their functionalities. DevConnect
Compliance Testing is not intended to substitute full product performance or feature testing
performed by DevConnect members, nor is it to be construed as an endorsement by Avaya of
the suitability or completeness of a DevConnect member’s solution.

The interoperability compliance testing focused on verifying inbound and outbound call flows
between IPTF and the Customer Premises Equipment (CPE) containing the Avaya IP Office
Release 10 (see Section 3.2 for call flow examples).

The test environment described in these Application Notes consisted of:
e A simulated enterprise with Avaya IP Office 10, Avaya SIP, H.323 and Analog
telephones, as well as a fax machine emulator (Ventafax).

e Laboratory versions of the IPTF service, to which the simulated enterprise was
connected via AVPN/MIS transport.

L AVPN uses compressed RTP (cRTP).
2 MIS/PNT does not support cRTP.
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2.1. Interoperability Compliance Testing

The compliance testing was based on a test plan provided by AT&T, for the functionality
required for certification as a solution supported on the IPTF network. Calls were made from
the PSTN across the IPTF test network, to the CPE.

The interoperability compliance testing focused on verifying inbound call flows (see Section
3.2) between Avaya IP Office and the IPTF service.

The compliance testing was based on a test plan provided by AT&T, for the functionality
required for certification as a solution supported on the AT&T network.

The following SIP trunking VolP features were tested with the IPTF service:

Incoming calls from PSTN, routed by the IPTF service, to Avaya IP Office. These
calls are via the Avaya IP Office SIP Line and may be generated/answered by Avaya
SIP telephones/Softphones, H.323 telephones, Analog telephones, Analog fax
machines or via Hunt Groups. Coverage to Voicemail Pro, and VVoicemail Pro auto-
attendant applications, were also used.

Inbound fax using T.38 or G.711, and G3 or SG3 endpoints.

Proper disconnect when the caller abandons a call before answer, and when the Avaya
IP Office party or the PSTN party terminates an active call.

Proper busy tone heard when an Avaya IP Office user calls a busy PSTN user, or a
PSTN user calls a busy Avaya IP Office user (i.e., if no redirection was configured for
user busy conditions).

SIP OPTIONS monitoring of the health of the SIP trunk. In the reference
configuration Avaya IP Office sent OPTIONS to the IPTF service Border Element and
AT&T responded with 405 Method Not Allowed (which is the expected response).
That response is sufficient for Avaya IP Office to consider the connection up.
Incoming calls using the G.729A and G.711 ULAW codecs.

Long duration calls.

DTMF transmission (RFC 2833) for successful voice mail navigation, including
navigation of a simple auto-attendant application configured on VVoicemail Pro, as well
as IPTF DTMF generated features.

Telephony features such as call waiting, hold, transfer, and conference.

Verify reception of IPTF SIP Multipart/NSS headers, including SDP and XML
content.

AT&T IP Toll Free features such as Legacy Transfer Connect and Alternate
Destination Routing.
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2.2. Test Results
The test objectives stated in Section 2.1, with limitations as noted below, were verified.

1. Avaya IP Office only supports a packet size (ptime) of 20 msecs, and therefore
does not specify a ptime value in the SIP SDP (in either requests or responses).
e Although no issues were found during testing, AT&T recommends that for
maximum customer bandwidth utilization, a ptime value of 30 should be
specified.

2. IP Toll Free ADR Call Redirection feature based on SIP error code response.
Upon receiving an error response, IPTF service can be configured to invoke ADR Call
Redirection. The following error codes were producible by the reference configuration
and tested successfully; 408 Request Timeout, 480 Temporarily Unavailable, 486
Busy Here, and 503 Service Unavailable. The following error codes are also supported
by IPTF service, but were not producible by the reference configuration, and thus not
tested; 500 Server Internal Error, 504 Server Timeout, and 600 Busy Everywhere.

3. Enhanced CID — NSS feature. The inbound calls to Avaya IP Office are not
exercising the Enhanced CID feature. Although Avaya IP Office is accepting SIP
Multipart/NSS headers, it is neither passing nor acting upon it. It is simply being
ignored.

2.3. Support

AT&T customers may obtain support for the AT&T IP Toll Free service by calling (800) 325-
5555.

Avaya customers may obtain documentation and support for Avaya products by visiting:
http://support.avaya.com. In the United States, (866) GO-AVAYA (866-462-8292) provides
access to overall sales and service support menus. Customers may also use specific numbers
(provided on http://support.avaya.com) to directly access specific support and consultation
services based upon their Avaya support agreements.

3. Reference Configuration

Note — Documents used to provision the test environment are listed in Section 9. References
to these documents are indicated by the notation [x], where x is the document reference
number.

The reference configuration used in these Application Notes is shown in Figure 1 on the next

page and consists of the following components:

e An Avaya Server Edition Primary server with an IP500 V2 Expansion System for fax and
digital endpoint support. The single Server Edition Primary server provides IP Office
Server Edition, Voicemail Pro, and Avaya one-X® Portal for IP Office.
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e Auvaya IP Office Server Edition provides the voice communications services for a
particular enterprise site.

e Voicemail Pro provides the voice messaging capabilities in the reference configuration.
This solution is extensible to the standalone IP Office 500V2 Embedded Voicemail as
well.

e Avaya “desk” telephones are represented with an Avaya 1616 H.323 set, an Avaya 9611
H.323 set, an Avaya 9508 Digital set, an Avaya 1140E SIP set, as well as Avaya
Communicator for Windows (SIP). Fax endpoints are represented by PCs running
Ventafax emulation software connected by modem to an Avaya IP Office 500 V2 analog
port.

e In the reference configuration, Avaya IP Office interface “LAN 1” is connected to the
private CPE, and interface “LAN 2” is connected to the public network and AT&T.

e The AT&T IPTF service requires the following SIP trunk network settings between the
Avaya IP Office LAN 2 (SIP Trunk) interface and the IPTF Border Element:

o UDP transport using port 5060
o RTP port ranges 16384-32767

e AT&T provided the inbound and outbound access numbers (DID and DNIS) used in the
reference configuration. Note that the IPTF service may deliver various digit lengths in the
SIP Invite R-URI depending on the circuit order provisioning. In the reference
configuration, the IPTF service delivered 15 digits.

AT&T AVPN or MIS/PNT
Transport Network

AT&T IP Toll Free

192.168.225.210

AT&T Router

PLBLIC IP ADDRESS SPACE {)

IP Office Location LANZ: 192.163.80.43

————
1P Office Server Edition

LAN1:10.64.19.170
1P500v2 Expansion Server
10.64.19.66 %
’—( PRIVATE IP ADDRESS SPACE (Oomome [)

E® 9 § L v N

DigtatPhone.  Devices Avaya 1616 Avaya 9611 Aveya 1140 Avays Comniluieatar s
X623 X6217 for Windows
*H239 Manager

Figure 1: Reference Configuration
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3.1. lllustrative Configuration Information

The specific values listed in Table 1 below and in subsequent sections are used in the reference
configuration described in these Application Notes, and are for illustrative purposes only.
Customers must obtain and use the values based on their own specific configurations.

Note — The Avaya IP Office Server Edition LAN 2 interface is defined as the SIP trunk (see
Section 5.3.3) and communicates with AT&T Border Elements (BESs) located in the AT&T
IPTF network. For security reasons, the IP addresses of the AT&T BEs are not included in
this document. However as placeholders in the following configuration sections, the IP
addresses 192.168.80.42 (Avaya IP Office Server Edition LAN 2 address), and
192.168.225.210 (AT&T BE IP address), are specified. In addition, AT&T DID/DNIS
numbers shown in this document are examples as well. AT&T Customer Care will provide the
actual Border Element IP addresses and DID/DNIS numbers as part of the IPTF provisioning
process.

Component Illustrative Value in these
Application Notes

Avaya IP Office Server Edition
Private network LAN1 interface 10.64.19.170
Public network LANZ2 interface 192.168.80.42
Avaya IP Office Expansion System (IP500 V2)
Private network LAN1 interface \ 10.64.19.66
AT&T IPTF Service
Border Element IP Address \ 192.168.225.210

Table 1: Hlustrative Values Used in these Application Notes
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3.2. Call Flows

To understand how inbound AT&T IPTF service calls are handled by Avaya IP Office, two
basic call flows are described in this section.

3.2.1. Inbound

The first call scenario illustrated in the figure below is an inbound AT&T IPTF service call
that arrives on Avaya IP Office, which in turn routes the call to a hunt group, phone or a fax
endpoint.

1. A PSTN phone originates a call to an IPTF service number.
2. The PSTN routes the call to the AT&T IPTF service network.
3. The AT&T IPTF service routes the call to Avaya IP Office.
4. Avaya IP Office applies any necessary digit manipulations based upon the DID and
routes the call to a hunt group, phone or a fax endpoint.
( ATET )
w PSTN _2_7 1P Toll Free
( /-) Service /_)
PSTN
Phone k N \_/-*—/ L’ o
57
Avaya
IP Office
i.:
5
Phone
Figure 2: Inbound AT&T IPTF Call
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3.2.2. Coverage to Voicemail

The call scenario illustrated in the figure below is an inbound call that is covered to
Voicemail. In the reference configuration, the VVoicemail system used is Voicemail Pro,

running on Avaya Server Edition Primary server.

1. Same as the first call scenario in Section 3.2.1.
2. The Avaya IP Office phone does not answer the call, and the call covers to Voicemail

Pro.

NV N\~

s

%—L PSTN \)
e J) Smiuf)
Phone

-\

Avaya
Yoicemail
Pro

~N \
(’ ATET ’\3
._'- “IP Toll Free
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Avaya
IP Office

214’

g

Phone

Figure 3: Coverage to Voicemail (Voicemail Pro)
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4. Equipment and Software Validated

The following equipment and software was used for the reference configuration described in

these Application Notes.

Equipment/Software

Release/Version

Avaya IP Office Server Edition
= |P Office
= Voicemail Pro
= Avaya WebRTC Gateway
= Avaya one-X® Portal for IP Office

10.0.0.0.0 build 550
10.0.0.0.0 build 469
10.0.0.0.0 build 140
10.0.0.0.0 build 980

Avaya IP Office 500 V2
= Avaya IP Office TCM 8
= Avaya IP Office COMBO6210/ATM4

10.0.0.0.0 build 550
10.0.0.0.0 build 550

Avaya IP Office Server Edition Manager

10.0.0.0.0 build 550

Avaya Communicator for Windows (SIP) 2.1.3.237
Avaya 9641G (H.323) IP Deskphone 6.6229
Avaya 1616 (H.323) Telephone Hal616ual 390A.bin
Avaya 1140E (SIP) Telephone 04.04.23
Avaya 9508 Digital Telephone 0.55

Analog Fax device Ventafax 6.3

Table 2: Equipment and Software Versions

Note — Compliance Testing is applicable when the tested solution is deployed with a
standalone IP Office 500 V2, and also when deployed with all configurations of IP Office
Server Edition. IP Office Server Edition requires an Expansion IP Office 500 V2 to support

analog or digital endpoints or trunks.
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5. Avaya IP Office Primary Configuration

Note — This section describes attributes of the reference configuration, but is not meant to be
prescriptive. In the following sections, only the parameters that are highlighted in bold text
are applicable to the reference configuration. Other parameter values may or may not match
based on local configurations. Many forms contain multiple tabs. Only those tabs with
provisioning related to the reference configuration are discussed. Any other tab/form should
be considered default values. Additionally, the screen shots referenced in these sections may
not be the complete form.

IP Office is configured via the IP Office Manager program. For more information on IP
Office Manager, consult reference [3]. From the IP Office Manager PC, select Start = All
Apps =2 IP Office 2 Manager to launch the Manager application. Navigate to File > Open
Configuration (not shown), select the proper Avaya IP Office system from the pop-up
window, and log in using the appropriate credentials.

B w2 O

On Server Edition systems, the Solution View screen will appear, similar to the one shown on
next page. If the left navigation pane does not immediately appear, click on the
Configuration link as highlighted below. In the reference configuration, IP users registered to
the Primary server and failover to the Secondary server. Digital and Analog users are
configured on the Expansion System. A SIP trunk to the AT&T IPTF service is configured on
the Primary server. Clicking the “plus” sign next to the Primary server system name, e.g.,
IPOSE-Primary, on the left navigation pane will expand the menu on this server.
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5.1. IP Route

In the sample configuration, the Primary server LAN1 port is physically connected to the CPE
network. The default gateway for this network is 10.64.19.1.

IP Route

P Address

P Mask

Gateway IF Address
Destination

Metr

The Primary server LAN2 port is physically connected to the AT&T network and has a
default gateway of 192.168.80.1. To add an IP Route in IP Office, right-click IP Route from
the Navigation pane, and select New (not shown). To view or edit an existing route, select IP
Route from the Navigation pane, and select the appropriate route from the Group pane. The
following screen shows the Details pane with the relevant route using Destination LAN2 (to

AT&T).

o
53
b
<

IP Routs

P Addrem

P Mask

Gateway IP Address
Destation

BMetric
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5.2. Licensing

In the sample configuration, IPOSE-Primary was used as the system name of the Primary
Server, IPOSE-Secondary was used as the system name of the Secondary Server and 1P500
Expansion was used as the system name of the Expansion System. All navigation described
in the following sections (e.g., License) appears as submenus underneath the system name in
the Navigation Pane.

The configuration and features described in these Application Notes require the IP Office
system to be licensed appropriately. If a desired feature is not enabled or there is insufficient
capacity, contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity, click License in
the Navigation pane. Confirm a valid SIP Trunk Channels license with sufficient Instances
(trunk channels).
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On the Remote Server tab, set the SIP Trunk Sessions to a value sufficient for the number
of simultaneous SIP trunk calls needed.
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5.3. System Settings

This section illustrates the configuration of system settings. Select System in the Navigation
pane to configure these settings. The subsection order corresponds to a left to right navigation
of the tabs in the Details pane for System settings. For all of the following configuration
sections, the OK button (not shown) must be selected in order for any changes to be saved.

5.3.1. LAN1Tab

In the reference configuration, LAN1 was used to connect the Avaya IP Office to the CPE
network (see Section 3).

5.3.1.1 LAN1-LAN Settings Tab

To view or configure the LAN 1 IP address, select the LAN 1 - LAN Settings tab, and enter
the following:
e IP Address: Setto 10.64.19.170 as specified in the reference configuration.

et (81 Dreabsind Advarced

DDT; Reviewed: Solution & Interoperability Test Lab Application Notes 13 of 49
SPOC 10/11/2016 ©2016 Avaya Inc. All Rights Reserved. IPO10TF



5.3.1.2 LAN 1 - VoIP Tab

Select the LAN1 - VolIP tab as shown in the following screen. The following settings were
used in the reference configuration:

e The H323 Gatekeeper Enable box is checked to allow the use of Avaya IP

Telephones using the H.323 protocol, such as the Avaya 1600-Series Telephones used
in the reference configuration.
e The SIP Registrar Enable box is checked to allow Avaya 11xx (SIP) and Avaya IP
Office Softphone (SIP) usage.

e The SIP Domain Name used in the reference configuration is

silipose.customera.com.

e The SIP Registrar FQDN used in the reference configuration is

silipose.customera.com.

e Inthe Layer 4 Protocol section, select UDP/5060, TCP/5060, TLS/5061.

e Let all other values default.
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5.3.2. LAN2Tab

The LAN 2 interface is used for the SIP trunk connection to AT&T.

In the sample configuration, LANZ is used to connect the IP Office to the AT&T network. To
view or configure the IP Address of LANZ2, select the LANZ tab followed by the LAN
Settings tab. As shown in Figure 1, the IP Address of the IP Office, known to AT&T, is
192.168.80.43. DHCP Mode is set to Disabled since DHCP is unnecessary towards AT&T.
Other parameters on this screen may be set according to customer requirements

5.3.2.1 LAN 2 - LAN Settings Tab

e IP Address: In the reference configuration the IP Office public address is
192.168.80.43.
e Other parameters on this screen are set to their defaults.

Configuration = System  |= IPOSE-Primary v
R ﬁc"-'”: '1“_' Name Systern LANY  LANZ  DNS  Voicemail Telephony Dasctory Services System Events SMTP SMDR Vol (¢ ' »
i+ Operator (3) S IPOSE-Primary
& Sokstion LAN Settings  YolP Network Topology
IP Address w 168 [-5] a3
IP Mask
Number Of DHCP IP Addvesses 200
PHCP Mode
Server () Client (@) Disabled Adheanced
Controf Uit (1
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5.3.2.2 LAN 2 - VoIP Tab
Select the LAN2 - VolIP tab as shown in the following screen. The following settings were
used in the reference configuration
e Select the SIP Trunks Enabled option.
e RTP Port Number Range: The AT&T IPTF service requires that the RTP use the
port range 16384 to 32767.
o 16384 entered in the Port Range (Minimum) field.
o 32766 entered in the Port Range (Maximum) field, as this field requires even

numbers.
_ Confguration | System | IPOSE Primary ‘
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e To prevent possible issues with network firewalls closing idle RTP channels, it is
recommended that RTP Keepalives are enabled. Scrolling down to the bottom of the
form, enter the following:

o Scope: Select RTP-RTCP
o Periodic Timeout: Enter 30
o Initial keepalives: Select Enabled
e Other parameters on this screen are set to the defaults.

Sysiem ]li: m v
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5.3.2.3 LAN 2 - Network Topology Tab

e The Firewall/NAT Type is set to Open Internet in the reference configuration.

Note — the Firewall/NAT Type parameter may need to be set differently, depending if

firewall and/or Network Address Translation (NAT) devices are used at the customer

premise.

e Binding Refresh Time: This field specifies how often IP Office will issue a SIP
OPTIONS message to check the SIP trunk connection status to AT&T. In the
reference configuration, 120 secs is specified.

e Public IP Address: In the reference configuration the IP Office public address is
192.168.80.43.

e Set the Public Port to UDP/5060.
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5.3.3. Telephony Tab

To view or change telephony settings, select the Telephony tab and Telephony sub-tab as
shown below. The settings presented here simply illustrate the values used in the reference
configuration and are not intended to be prescriptive.

e Uncheck the Inhibit Off-Switch Forward/Transfer box. This is so that call
forwarding and call transfer to PSTN destinations via the AT&T IPTF service can be
tested.

e Set the Companding Law parameters to U-LAW as is typical in North America.

e Default values are used in the other fields.

_ Configuration | System = IPOSE-Primary
K B00T (11 ame B A

POSL-Pvmany
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3 2@IX I BOOTA™S | 1055
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5.3.4. VoIP Tab

On the left, observe the list of Available Codecs. By selecting codecs in this column, they
will appear in the Default Codec Selection = Unused column. Codecs may be selected from
the Unused list and moved to the Selected column by use of the >>> button, thereby making
the selected codecs available in other screens where codec configuration may be performed
(e.g., SIP Lines and Extensions).

The up and down arrow buttons are used to order the selected codecs. By default, all IP (SIP
and H.323) lines and extensions will assume the system default Selected codec list, unless
configured otherwise for the specific SIP Line or extension (see the note below).
e Populate the Selected column with G.711 ULAW 64K as the first codec and G.729(a)
8K CS-ACELP as the second codec.
¢ Inthe RFC2833 Default Payload setting field, specify 100, which is the
recommended value for AT&T interoperability.

DDT; Reviewed: Solution & Interoperability Test Lab Application Notes 18 of 49
SPOC 10/11/2016 ©2016 Avaya Inc. All Rights Reserved. IPO10TF



Note — In the reference configuration, the Extension codec lists (see Section 5.6.2) also
specify G.711ULAW and G.729(a) (in that order), and the SIP Line (see Section 5.4.6) offers
G.729(a) and G.711ULAW (in that order). In this manner, local Avaya IP Office calls will
offer G.711mu first, and SIP trunk calls will offer G.729A first.

1= WOBE Primary
Name
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O®Ta=s i izi;

veovevy Call Route

5.4. SIP Line

The following sections describe the configuration of a SIP Line. The SIP Line terminates the
CPE end of the SIP trunk to the AT&T IPTF service.

The recommended method for creating/configuring a SIP Line is to use the template
associated with the provisioning described in these Application Notes. The template is an .xml
file that can be used by Avaya IP Office Manager to create a new SIP Line for SIP trunking
with the AT&T IPTF service. Follow the steps in Section 5.4.2 to create a SIP Trunk from the
template.

Some items relevant to a specific customer environment are not included in the template or
may need to be updated after the SIP Line is created. Examples include the following:

e |P addresses

e SIP Credentials (if applicable)

e SIP URI entries

e Setting of the Use Network Topology Info field on the Transport tab.
Therefore, it is important that the SIP Line configuration be reviewed and updated if
necessary, after the SIP Line is created via the template. The resulting SIP Line data can be
verified against the manual configuration as shown in Sections 5.4.3 —5.4.8.

In addition, the following SIP Line settings are not supported on Basic Edition:
SIL Line — Originator number for forwarded and twinning calls
Transport — Second Explicit DNS Server

SIP Credentials — Registration Requirements

SIP Advanced Engineering
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Alternatively, a SIP Line can be created manually. To do so, right-click Line in the
Navigation Pane and select New > SIP Line. Then, follow the steps outlined in Sections
54.3-5.4.8.

5.4.1. Importing a SIP Line Template

Note — DevConnect generated SIP Line templates are always exported in an XML format.
These XML templates do not include sensitive customer specific information and are
therefore suitable for distribution. The XML format templates can be used to create SIP
trunks on both IP Office Standard Edition (IP500 V2) and IP Office Server Edition
systems. Alternatively, binary templates may be generated. However, binary templates
include all the configuration parameters of the Trunk, including sensitive customer
specific information. Therefore, binary templates should only be used for cloning trunks
within a specific customer’s environment.

1. Copy a previously created template file to a location (e.g., \temp) on the same
computer where IP Office Manager is installed.

2. Import the template into IP Office Manager. From IP Office Manager, select Tools -
Import Templates in Manager.

ble fde Yew Toon  Help
.| ferion Renumber |

Selunon

Server Edton Service User Masagement [

By on Heid Velidabon |

ASN Configuration W

mpornt Tempiates i Manager |

Liceram Migration

3. A folder browser will open (not shown). Select the directory used in step 1 to store the
template(s) (e.g., \temp). In the reference configuration, template file IPO10TF.xml
was imported. The template files are automatically copied into the IP Office default
template location, C:\Program Files\Avaya\lP Office\Manager\Templates.

4. After the import is complete, a final import status pop-up window will open stating
success or failure.

Template Provisioning *

Successfully imported templates to IP Office Manager from
Ch\Temp
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5.4.2. Creating a SIP Trunk from an XML Template

1. To create the SIP Trunk from a template, right-click on Line in the Navigation Pane,
and hover over New from Template, and select Open from file.

] Mew 3
Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+V
Delete Ctri+Del

Validate

Mew from Template » Open from file

Show In Groups

Customize Columns...

Navigate to C:\Program Files\Avaya\lP Office\Manager\Templates. Select *.xml as the
file type, find the template, and click Open.

-

The newly created SIP Line will appear in the Navigation pane (e.g., SIP Line 2).

Line Mumber Line Type Line SubType

b M IP Office Line WebSocket Server SCM
e 3 IP Office Line WebSocket Server SCM
2 SIP Line

Once the SIP Line is created, verify the configuration of the SIP Line with the configuration
shown in Sections 5.4.3 —5.4.8.

5.4.3. SIP Line - SIP Line tab

The SIP Line tab is shown below for Line Number 2, used for the SIP Trunk to AT&T.
Note, if no SIP Line exists, right click on the Line item in the Navigation pane and select
New => SIP Line (not shown). In the reference configuration, SIP Line 2 was created. The
SIP Line form is completed as follows:
e |ITSP Domain Name: Set to the IP address of the AT&T Border Element IP address
(e.g., 192.168.225.210).
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Local Domain Name: Set to the IP address of the Avaya IP Office LAN2 SIP

trunking interface (e.g., 192.168.80.43).

In Service and Check OOS: These boxes are checked (default).

Refresh Method: Set to Re-Invite, as AT&T does not support UPDATE.
Incoming Supervised Refer: Set this field to Auto (default).

Outgoing Supervised Refer: Set this field to Auto (default).

Send 302 Moved Temporarily: Verify this field is unchecked (default).
Outgoing Blind REFER: Verify this field is unchecked (default).

Use the default values for the other fields.
Click OK (not shown).

B (2T

........

5.4.4. SIP Line - Transport tab
Select the SIP Line = Transport tab and configure the following:

DDT; Reviewed:

ITSP Proxy Address: Set to the AT&T Border Element IP address (e.g.,

192.168.225.210).
Network Configuration - Layer 4 Protocol: Setto UDP.

Network Configuration - Send Port: Set to 5060 (default).
Network Configuration - Use Network Topology Info: Set to LAN 2.
Calls Route via Registrar: Verify this field is checked (default).

Click OK (not shown).

SIP Line Transport SIP URI VolP  SIP Credentials SIP Advanced Engineering

ITSP Proxy Address |192.168.225.210

Metwork Configuration
Layer 4 Protocol upp ~ Send Port 5060

Use Metwork Topolegy Info | LAMN 2 ~

Explicit DNS Server(s) 0 0 0 0 0 0 0 0

Calls Route via Registrar

Separate Registrar |
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5.45. SIP Line - SIP URI tab

Select the SIP Line - SIP URI tab. To add a new SIP URI, click the Add... button. At the
bottom of the screen, a New Channel area will be opened. Configure the following:

e Local URI, Contact, and Display Name fields: Set these fields to Auto. This setting
replaces the wildcard “*” used in previous releases.

e Verify Identity, Send Caller ID, and Diversion Header: Set to the default None.

e Verify Registration: Set to the default 0: <None>.

e Incoming Group: Set to an unused group number, e.g., 3. This value references the
table created with Incoming Call Routes in Section 5.7.

e Outbound Group: Set to an unused group number, e.g., 3.

e Max Sessions: In the reference configuration this was set to 10. This sets the
maximum number of simultaneous calls that can use the URI before Avaya IP Office
returns busy to any further calls.

e Click OK.

SIP Line Transport SIPURI VolP  SIP Credentials SIP Advanced Engineering

URl  Groups Local URI Contact Display Name Identity Header Originator Mumber Send Caller ID Diversion Header Creden’ Add.. ™
1 33 Auto Auto Auto Mone  PAI None Mone 0 <Noj
Remove
Edit...
Edit URI 0K
Local URI [Auto <]
Cancel

Contact ‘Auto V|

Display Name ‘Autu v|

Identity

Identity |N0ne v|

Header P Asserted ID ~

Forwarding And Twinning

COriginater
Number

Send Caller ID None -

Diversion Header ‘None v

Registration 0: <None> ~

Inceming Group

Max Sessions 0

e To edit an existing entry, click an entry in the list and click the Edit button.

e When all SIP URI entries have been added or edited, click OK at the bottom of the screen
(not shown).
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5.4.6. SIP Line - VoIP tab

Select the SIP Line = VolP tab and enter the following:

e The Codec Selection drop-down box = System Default will list all available codecs.
In the reference configuration, Custom was selected and G729(a) 8K CS-ACELP,
and G.711 ULAW 64K were specified. This causes Avaya IP Office to include these
codecs in the Session Description Protocol (SDP) offer, and in the order specified.
Note that in the reference configuration G.729A is set as the preferred codec on the
SIP trunk to the AT&T IPTF network (see the note below regarding IPTF and Silence
Supression).

e T.38 fax was used in the reference configuration. Set the Fax Transport Support
drop-down menu to T38. G.711 fax also worked in the reference configuration (T.38
option disabled); however, T.38 is the preferred method.

e The Re-invite Supported parameter can be checked to allow for codec re-negotiation
in cases where the target of an incoming call or transfer does not support the codec
originally negotiated on the trunk.

e The DTMF Support parameter can remain set to the default value
RFC2833/RFC4733.

e Click OK (not shown).

SIP Line Transport SIP URI VelP  SIP Credentials SIP Advanced Engineering
[ Local Hold Music

Re-invite Supported

Codec Selection Custom > [ Codec Lockdown
Unused Selected [] Allow Direct Media Path
G711 ALAW 64K . G.72%(a) 8K C5-ACELP Force dir fia with oh
G.722 64K G711 ULAW 64K orce direct media with phones

[] PRACK/100rel Supported

<<

Fax Transport Support | T38 ~
DTMF Support RFC2833/RFC4733 ~
Media Security Disabled ~

5.4.7. SIP Line-T38 Fax Tab

Note — This tab is only available when configuring a SIP line on IP Office 500 V2,
and the settings on this tab are only accessible if Re-invite Supported and a Fax
Transport Support option (T38) are selected on the VVolIP tab (Section 5.4.6).
See Section 6.4 for T.38 fax settings.
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5.4.8. SIP Line — SIP Advanced Tab

IP Office can be configured to signal when a call is placed on hold by sending an INVITE
with media attribute “sendonly”. AT&T in turn will respond with media attribute “recvonly”,
and will stop sending RTP media for the duration the call is on hold. When the call is taken
off of hold, IP Office will send another INVITE with media attribute “sendrecv” indicating to

AT&T to start sending RTP again.

To have Avaya IP Office signal to AT&T when a call is placed on/off hold, select the SIP

Line = SIP Advanced tab and enter the following:
e Select Indicate HOLD.

Addressing
Aszocistion Method

Call Routing Method

Identity

Use “phone-context”
Add user=phone

Use « for intemational
Lve PAL for Peivacy

Use Doman for PAI

Send From in Cleas

Cache Auth Credentials

Send Lecation Indo

SIP Line Transport SP URI YolP

Suppress DNS SRV Lookups

Swap From and PAI/Diversion

Caller 10 from From header

User-Agent and Server Headen

S Credentuls 5P Advanced Engineenng

By Source 1P acldress

Reguest UR)

Ccoooooon

=

Never

Meca

Allow Empty INVITE
Send Empty re-INVITE
Allow To Tag Change
P.Early-Medis Suppon
Send SéenceSupps Off

Media Connection
o3

!_A
(i
L
None

O

Disabled

Indecate ROLD

Call Contral

Call intiation Timeout (s}
Call Quewng Timeout (mins,
Service Buty Response

on No User Responding Send
Action en CAC Locatian Lime

Suppress Q550 Resson
Hesder
Emulate NOTFY for REFER

Ne REFER # using Deversion

503 - Service Unavdable
£08-Reguest Timeout
Abow Yoicemail

O
|
]

DDT; Reviewed:
SPOC 10/11/2016

Solution & Interoperability Test Lab Application Notes

©2016 Avaya Inc. All Rights Reserved.

25 of 49
IPO10TF



5.5. IP Office Line

IP Office Lines are automatically created on each server when a Secondary server or
Expansion System is added to the solution. To edit an existing IP Office Line, select Line in
the Navigation pane, and select the appropriate Line to be configured in the Group pane.
Below is the IP Office Line to the Expansion System.

b e Wl
8 Locatmeid)
W POSE Parrary

Line

|

1P Ofce Line - Line 1

Lave Numbnr  Line Type

P Omce Lne .m{
58 Line
P O¥celine
50 L
Pl
¥ Lo

i
welt

B Lee Numbe
Tieragoot Type
Nebwaihing Level

Secwey

Gareany
Akt
Locatise
Pasrmars

Cordrm Pesvwocd

Descrstion

NS U Shom Code 2P Settmge

|

WebsSachet Senver L
SCN gy oD "
Medam HNarmbies of Ovaversty

Tebephone Hurmbe

Cutgoong Chaneels

YCM Aesfincy Opsoms

7] Supparm Sanbancy
U1 Backs up my B pones
] By wp vy hware growpe

7] Backs ug my P DECT phanes

In the reference configuration, a fax machine is connected to one of the analog ports on the
Expansion System. To accommodate T.38 fax, select the VolP Settings tab and configure the

following:

e Fax Transport Support: T38

|

~fROSTIE™,

* {
89 Attt Conbe

Call meutsoe Tarwos o

Mada Securty

i

Line E I Office Line « Line 1

Live Nundee  Line Type Love SebW (L Shert Coden Veib Settngs

- P e Lme WebSockd

i P Offielme  WebSock

~ 59 Lie [*
il P Lo Coder Schoctmr Cartarn

Do P Lna Uwiad Sebectet

-t i GT1 ALAW BiK G 72| 6K C5ACELD

G.722 pax QT LA S4C
Fas Vaenpont Sapppont ™

Sarre ss Syvten (Dsatded]
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5.6. Users, Extensions, and Hunt Groups

In this section, examples of Avaya IP Office Users, Extensions, and Hunt Groups are
illustrated. Note that the following examples do not discuss all available options, and the
screen shots may not display all available parameters. Parameters/options not discussed,
should assume to be default.

5.6.1. Analog User 6300

The following screen shows the User tab for analog phone User 6300. This user corresponds
to a fax machine.
1. Toadd a User, right click on User in the Navigation pane, and select New (not
shown). To edit an existing User, select User in the Navigation pane, and select the
appropriate user to be configured.

User I= IP500 Expansion : Fax: 6300 N X v« -
P Office Mame Btenmort e S - . - - ~Ts
Py SR o o Vorcerail DD Short Codes  Source Numbers  Telephony Forwerding  Disl i Vouce Recording - Button Progremmng
PW0 Bapansion  EcnSiN G ,.
BP0 bpensiom  ATT-Avaya 9508 6324 Marme Fax
ATT-scétphone 6333 Passwerd csssssnnree
ATT-Avaya 9811 a3z
1 & Corfem Pevwword srsssenree
!_‘?::I Ursgue ldentity
6300
a2 Coréerence PN
Z‘: Corfem Audo Conference PIN
Avays 11406 a3 Account Status Enabled
Avays 1616 233
01 Full Name
i 28 Bxtenson &30
M
: o Email Asdress
i 2 Locale
"
: - Pricrity 5
i 08 Systerm Phoem Righty Mo
kv 7
i 0t -
‘ Profile Baie ey
i \J [ Receptonnt
H 03
‘ 0 .
- "
" el
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2. Analog (or digital) phone extension ports are either integral to the control unit or
added by the installation of an analog or digital phone expansion module. Analog (or
digital) extension records are automatically created for each physical extension port
within the system. These ports cannot be added or deleted manually. For Server
Edition, non-IP extensions are only supported on Expansion System (V2) units.

e To edit an existing analog extension, select the appropriate extension to be
configured (e.g., 6300).

Extension Anslogue Extension: 31 6300 I X v [
D Edtention Module Pert
& 2 BD!
& 80! 3
&1 BD! £300
o4 M - 4
&3 15 BD! 5 Calter Dusplay Type On
S 3 206 apt §
&7 2 op1 7 Devaca Type g
& 28 BD! 3
&ls L o2 Locanon System (2 Derveer)
N [
&0 2 BD2 {
&8 213 BD2 3
: ;‘:‘: ;1; 25" : Oiaabie Speskerphone O
&1 210 Bp2
~ 5000 &30 ¢

e Select the Analogue tab and verify that Standard Telephone is selected. Note that
even though a fax machine is connected, it needs to be classified as a standard
telephone.

e Click the OK button (not shown).

Extension ]|:: Analogue Extension; 31 6300 el X v - 8

1o Extenvicn  Modde Port Etensean  Anogue
& 2! 1 L & aaas k8
pe - 801 & Equpment Clasiification Fash Mook Pulse Width

4 ("] {50
&) 03 (o]} ) Qunt Hesdiet b Use Systerm Defaiats
€4 2 80 4 ) Paging Speakes
&5 m 1]
&k 206 801 5 ¥ Randed Tdephone
&7 07 201
o ¥ ot
o2 802
&1t a 802 : O N Pest Menage Wetng Lamp InSicatian Typs
&7 5 802 3 d
en M e 4 H Machine e
&3 n3 Bo2 5 ) MOH Seurcs
&30 M 802 —~
s o2 Hocik Peruittency X s m
S i -Tonl ..

5.6.2. IP Phone User 6237

1. Following the steps shown in Section 5.5.1, create a 9611 H.323 IP phone user (e.g.,
6237).
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e Password: This password is used by user applications such as SoftConsole, one-
X® Portal and TAPI, or users with Dial In access. Note that this is not the user's
phone login code (see the information on the Extension tab below), or their
Voicemail mailbox password (see information on the VVoicemail tab below).

e Conference PIN: This is the pin number used to access the user’s meet me
conference.

e The Profile parameter is set to Power User. This gives this user access to
additional Avaya P Office features. See [3] for more information.

Ay Avaye 9611: 6237° g4 % v - -

Locale Lirwted Shates (U5 Enghah)

The following screen shows the VVoicemail tab for user 6237. The VVoicemail On box is
checked and a VVoicemail password can be configured using the Voicemail Code and
Confirm Voicemail Code parameters.

User Voicemail DND Short Codes  Source Numbers  Telephony Forwarding  DialIn - Voice Recording  Button Programming  Menu Programming

Voicemail Code |0000 | Voicemail On
Confirm Voicemnail Code |"" | [] Voicemail Help
Voicemnail Email | | [ Voicemail Ringback

Voicemail Email Reading
UMS Web Services
Enable GMAIL API

Off Copy Forward Alert

2. To create an associated extension, right click on Extension in the Navigation Pane,
and select New - H323 Extension.
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On the Extension tab, enter the Base Extension (e.g., 6237). Note that the Extension ID
field will auto populate. The Phone Password will be used by the telephone user as the
phone login password.

Extension | = H323 Extension: 11208 6237 g-dix v <.}
¢ Eternmm Medie Bl paecion @
11220 un ] di _
110 8 4l Wteescao ‘e
- 1A R 1 4 BeceExtunezn \ddd
- ) |
~ 113 y 4l Phove Priswed sove
- 112 il Cerfim Phere Passwsre
- 1
-1 233 | Celler Dupley Yipe O
- 1138 R 9 Q1 Waoat Yosiame detwr Cade C
- 11 &N ) 4
R ! :
Lecman Ao
Fallsack Ax Mamate Werker Auta
Wodak
Foet

Duaabin Spashagtons

Select the VolP tab and provision the following:
e Keep the IP Address field as the default value (0.0.0.0).
e Populate the Selected column with G.711 ULAW 64K as the first codec and
G.729(a) 8K CS-ACELP as the second codec, (see Section 5.3.4).
e Click the OK button (not shown).

|E | H323 Extension; 11206 6237 ood X ¢ - @
W de B paemon WP
i
1 a - Erudls Foststat foc
N ey ov— osdbigye B yhuven
"
! 4l WAC Addee 2 O Of Banet OOMT
~ ! (
4 ( T
~ 1T Gl Coader Stacron Sxten Detagt ) Locwt Tooes
- £2) Alww Tuwcs Maka Fuev
i G| AL fx . G711 BN o
- 022 54 67000 I OS Al
-1
Yararm Licarse Maserve baape (7 orcocset toamme
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Wetls Sacury Same a Spcann Tkcsbiad)
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5.6.3. Hunt Groups

Users may also receive incoming calls as members of a hunt group. To configure a new hunt
group, right-click HuntGroup from the Navigation pane and select New. To view or edit an
existing hunt group, select HuntGroup from the Navigation pane, and the appropriate hunt

group from the Group pane.

1. The following screen shows the Hunt Group tab for hunt group Call Center. This hunt

group was configured to contain various IP Office extensions. In the reference

configuration, these telephones extensions are rung based on idle time, due to the Ring
Mode setting Longest Waiting. Click the Edit button to select/deselect from the User

List included in the Hunt Group from the list of available users.

Gesup

Queung Owverflow  Fallbeck  Vocemad

Call Conter

Lengess Warting

Voice Recording  Asnowncements 9P

Frafile

Exchode From Directery

No Andwer Time {sec)

Randard Hamt Gring

Syem Defaut (13

Scurce No Change

31

2. Under the Queuing tab, check the Queuing On box and set the Queue Length field to

any desirable value. Use the default values for all the other fields.

Group Queuing Owerflow Fallback Voicemail Voice Recording Announcements SIP
Cueuing On
Queue Length b = MNormalize Queue Length
CQueue Type Assign Call On Agent Answer w
Calls In Queue Alarm

Calls In Queue Threshold 1 =

4

Analog Extension to Notify | <None> -
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3. Under the Announcements tab, check the Announcements On box. The wait time can be
set to any desirable value. The Synchronize Calls box is checked to greatly reduce the
number voicemail channels needed to play announcements. These announcements are
played if an agent for a particular skill is unavailable.

Group Queuing Overflow Fallback Voicemail VoiceRecording Announcements Sip

Announcements On
Wait before 15t announcement (sec) |3 = Synchrenize Calls

Flag call as answered

Play 1st announcement

—Fe O —

Post announcement tone Music on hold ~

!

2nd Anncuncement

!
!

Play 2nd announcement —

l

Repeat last announcement

!

Wait before 2nd announcement (sec) 20

Wait before repeat (sec) 20

4. Click on OK (not shown).

In the reference configuration, these steps were used to create additional Hunt Group
“Support” (402).
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5.7. Incoming Call Routes

Note — The digits defined and matched in the Incoming Call Route table, are the DNIS digits
specified in the AT&T Request-URI, not the DID digits dialed by the caller.

The Incoming Call Route table will map specific AT&T DNIS numbers to an IP Office User,
or Hunt Group, as well as to Voicemail Pro scripts.

To add an incoming call route, right click on Incoming Call Route in the Navigation pane,
and select New (not shown). To edit an existing incoming call route, select an Incoming Call
Route in the Navigation pane, and the associated call route information is displayed in the
Group pane.

5.7.1. Calls to IP Office Stations and Hunt Groups
In the example below, the incoming number 000008885551025 is directed to H.323 phone
6237.
1. On the Standard tab enter the following:
e Line Group ID: Enter the SIP Line defined in Section 5.4 (e.g., 3).

e Incoming Number: Enter the associated DNIS digits sent by AT&T (e.g.,
000008885551025).

e Use default values for the remaining fields and click OK (not shown).

—

Configuration | = 3 000008885551025

-R BOOTP (14)
~{# Operator (3)
437 Solution
w-§  User (31)
3§ Group(4)
#-8X Short Code(55) Line Group ID E v
Directory(2)

Standard  Voice Recording  Destinations

Bearer Capability Any Voice ~

Time Profile(0)

: Account Code(0)
+-§5 User Rights(1)
+l§4_? Location(4)

=-%=1 |POSE-Primary
’;r---’-a- System (1)
-7 Line (6)

+ = Control Unit (8)
-4 Extension (10)
o User (14)

3§ Group (3)
+-@% Short Code (7)
B Service (0)

o F-dincoming Call Rof
=l IP Route (2)
% License (9)
i ARS (6)

Incoming Number
Incoming Sub Address
Incoming CLI

Locale

Priority

Tag

Hold Music Source

Ring Tene Override

|
|ooooossssss1 025 |
|
|

1-Low ~

System Source ~

|N0ne v|
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2. On the Destinations tab enter the following:
e In the Destinations column, select extension 6237 from the drop down menu.
e Use default values for the remaining fields and click OK (not shown).

= 3000008885661025 g TR
Standard Voice Recording  Destinationy
TimeProfile Destinstion Faloeck Exdenmion
» Default Velve 237 Avays 9641 : '

Below is an example of a call for 000008885551026 being directed to Hunt Group 401 (Call
Center).

Standard  Voice Recording  Destinations

Bearer Capability Any Voice ~
Line Group 1D |3 w
Incoming Number |DDDDDSSSSSS1 026

|
|
Incoming Sub Address | |
|

Incoming CLI |

Locale ~
Pricrity 1-Low ~
Tag | |
Held Music Source System Source ~
Ring Tone Cverride |N0ne v|
= 3 000008885551026 o X v <>
Standard Voice Recording Destinations
TimeProfile Destination Fallback Extension
4 Default Value 401 Call Center ~ ~
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5.7.2. Calls to Voicemail Pro Scripts

As described in Sections 5.6.1 and 5.8, VVoicemail Pro scripts are defined with specific names.
These script names are specified as destinations in the Incoming Call Route table.

In the example below, incoming number 000008885551027 is directed to the VVoicemail Pro
Auto-Attendant script ATT_IPTF.

1. On the Standard tab repeat the steps in Section 5.7.1, with the following changes:

e Incoming Number: Enter the associated DNIS digits sent by AT&T (e.g.,
000008885551027).

2. On the Destinations tab enter the following:

e In the Destinations column, enter the string VM:ATT _IPTF from the drop down
menu (note if the voicemail module does not appear in the list, enter the value
manually).

e Use default values for the remaining fields and click OK (not shown).

Standard  Voice Recording Destinations

Bearer Capability Any Voice ~
Line Group 1D |3 w
Incoming Number |DDDDDSSSSSS‘IDZ?

Incoming Sub Address |

Incoming CLI |

Locale ~

Priority 1- Low ~
Tag | |
Held Music Source System Source ~
Ring Tone Override |N0r‘|e v|
i= 3 000008885551027 i HKiv < =
Standard Voice Recording Destinations
TimeProfile Destination Fallback Extension
4 Default Value VM:ATT_IPTF ~ ~

5.8. Call Center Provisioning in Voicemail Pro

Note — While Voicemail Pro provisioning and programming is beyond the scope of this
document, a sample Auto-Attendant script is described below.

In the reference configuration, Voicemail Pro is used for VVoicemail processing as well as for
simulating basic Call Center functionality.

The Auto-Attendant function was provisioned to prompt callers to select a numeric option (1,
2, or 3), that would forward the call to an associated Avaya IP Office Hunt Group (Call
Center, and Support), or user 6237. This is accomplished via the following steps:
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Hunt Groups Call Center and Support are created in IP Office (Section 5.6.3).

User 6237 is created in IP Office (Section 5.6.2).

3. Incoming Call Route for DNIS digits 000008885551027 is defined for access to the Auto-
Attendant script (Section 5.7.2).

4. Viathe Voicemail Pro GUI interface:

e Open the Voicemail Pro Client application and log in to the VVoicemail Pro server
(not shown).

e Create a Start Point by right clicking on Modules and selecting Add.

N

T:I Voicemail Pro Client (Intuity) - Connected to 10

File Edit Actions  Administration  Help

H& & R2E: & g &

-2 IPOSE-Primary (10.64.19.170)
------ C:I Voicemail Pro Administrators
[]----tj Server Queues

------ tj Distributed Voicemails

------ cj Evenrting Notffications

Ty O
= Add

| Edit
Delete

| Rename

e Enter aname (e.g.,, ATT_IPTF) and click on OK (not shown). The new script
“ATT_IPTF” will appear under Modules and a Start Point icon will appear in the work

area.
Foe ":dl ;;t;c.n: ' -‘-dmr-'tra’h:'- :-ec S
A& 4d @ H-OHsE S R-J-E-B-F- A
2 1POSE Prmry (1068419 170 | pgy g gy 5 ATT_IPTE
:9 Yoarad Fro Adwrédrston
' O Server Gueues
D Dutiuted Vocerals | 2 ﬂ-f:'_ |
) Ererery Nosfemtens Ned '
= Medis
é ATT 17717
[
e Click on the Start Point icon __F=t_" to activate the script options at the top of the

EEE
[EIEE

screen. From the options, select the Basic Actions icon &ﬁ select the Menu icon omm,
and click on the work area to place the Menu icon.
i. Double click the Start Point icon.
1. Onthe General tab - Token Name, enter Start Point and click
OK (not shown).
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ii. Double click the Menu icon.

1. Onthe General tab - Token Name, enter Menu (not shown).

2. Onthe Entry Prompts tab (not shown), select or create an Entry
Prompt that will tell the caller what digits to press (e.g.,
mainmenu.wav). To modify an existing recording, double click on
the .wav file and rerecord. If no .wav files exist, double click on the

icon to open the .wav editor.
3. Onthe Touch Tone tab:
a. Select 1, 2, and 3 as the possible entry digits.
b. Select 3 for No of Retries.
4. Click on OK.

ropertes for Menu
Ganerd  Ertry Prompts  Touch Teres  Rapordng  Fesdts
e X

Il

nvabd ot Handing
=1 Mo of Reby o
O Of Metwes Fromet

A Tmeodt 3 3| secords -

OK _] Corcel Hegp

e Click on the Telephony Actions iconﬁ , select the Transfer icon ™ and click on the
work area to place the Transfer icon in the work area. This will be used for “Sales”.
Select and place two more Transfer Icons (these will be used for “Service” and
“Parts”).

i. Double click on the first Transfer icon (“Call Center”)
1. On the General tab > Token Name = Transfer to 401 - Call
Center (not shown).
2. On the Specific tab - Destination = 401 (not shown).
ii. Double click on the second Transfer icon (“Support”).
1. Onthe General tab - Token Name = Transfer to 402 - Support
(not shown).
2. On the Specific tab - Destination = 402 (not shown).
iii. Double Click on the third Transfer icon (“Ext6237”).
1. On the General tab, Token Name = Transfer to 6237 (not shown).
2. On the Specific tab, Destination = 6237 (not shown).

e From the options bar, select the Connector icon < and:
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i. Drag a connecting flow line from the Start Point box to the Menu box
(see screen shot below).

ii. Drag connecting flow lines from each of the Menu options to their
associated Transfer boxes (see screenshot below).

9 Voicernail Pro Client (intuity) - Connected to 10,64 15,170
Fle Edit Actions Administation Help
4 a £3_ 4 J P
H& &4 2@ G WO SR G-E-B-P-A-0
#-42D) POSEPamay (106413170
) Vocemad Pro Adnnstraton

i) Server Queves

o Distitntod Vocemaie I SISM
ﬂ Eventing Notfications _["”’

[ Modudes > ATT_IPTF

2 [Thwscis J—)i_‘",_'!!_'!_‘!‘i_r‘?'_'?*' |
TR

iy G Y| Lo

- | 5 Toniwios2st |

} Modules

oS ATTiFTF
o

5. From the top menu select File = Save & Make Live, or select the & icon.

When the associated AT&T DNIS number is received (e.g., 000008885551027), IP Office
will send the call to Voicemail Pro. The caller will be prompted to enter 1, 2, or 3 to access
Call Center, Support, or user 6237. The associated Avaya IP Office extension (e.g., 401, 402,
or 6237) will then ring.
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5.9. Saving Configuration Changes to Avaya IP Office

The provisioning changes made in Avaya IP Office Manager must be applied to the Avaya IP
Office server in order for the changes to take effect. As noted in the previous sections, any
changes made to an IP Office provisioning tab must be accepted by clicking OK on the
associated screen. However these changes will not take effect until they are written to the IP
Office configuration.

At the top of the Avaya IP Office Manager GUI, click File > Save Configuration (note that
if that option is grayed out, no changes are pending).

A screen similar to the one below will appear, with either Merge or Immediate automatically
selected, based on the nature of the configuration changes. The Merge option will save the
configuration change with no impact to the current system operation. The Immediate option
will save the configuration and cause the Avaya IP Office server to reboot.

Click OK to execute the save.

T send Multiple Configurations — O *
Select ) Change . Incoming Outgeing Error
P Office Made RebootTime Call Barring Call Barring Status Progress
» IPOSE-Primary | Merge v 10:17 AM O O n
IP500 Expansion | Merge ~ [10:17 AM | | n

The active configuration may be saved to a file at any time by selecting File = Save
Configuration As.
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6. Avaya IP Office Expansion Configuration

Navigate to File = Open Configuration (not shown), select the proper Avaya IP Office
system from the pop-up window, and log in using the appropriate credentials. Clicking the
“plus” sign next to IP500 Expansion on the left navigation pane will expand the menu on this
server.

CER b I R { s R

I FIROECGIrERA™Y iM%

s

yhon Cinde

6.1. Physical Hardware

In the sample configuration, looking at the Expansion System IP500 V2 from left to right, the
first module is a TCM 8 Digital Station Module. This module supports BCM / Norstar T-
Series and M-Series telephones. The second module is a COMBO6210/ATM4 module. This
module is used to add a combination of ports to an IP500 V2 control unit and is not supported
by IP500 control units. The module supports 10 voice compression channels. Codec support is
G.711, G729A and G.723 with 64ms echo cancellation. G.722 is supported by IP Office
Release 8.0 and higher. The “Combo” card will support 6 Digital Station ports for digital
stations in slots 1-6 (except 3800, 4100, 4400, 7400, M and T-Series), 2 Analog Extension
ports in slots 7-8, and 4 Analog Trunk ports in slots 9-12.

1= Server Edition

|

PO

4
<

@

Primary Lot Secondary Lk Usens Condgerod Eatanpeons Configused

8 POSE Prmary WL 19T Dethawy
# Secocdary Senvw  POSE-Secondiry W 619178 Bothrvwy
# Expancion Systam PS00 Expansico Y069 1966 Bothway Scthway 1% 16
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6.2. System Settings

This section illustrates the configuration of system settings. Select System in the Navigation
pane to configure these settings. The subsection order corresponds to a left to right navigation
of the tabs in the Details pane for System settings. For all of the following configuration
sections, the OK button (not shown) must be selected in order for any changes to be saved.

6.2.1.LAN Settings

In the sample configuration, LANL1 is used to connect the Expansion System to the enterprise
network. To view or configure the IP Address of LANL, select the LAN1 tab followed by the
LAN Settings tab. As shown in Figure 1, the IP Address of the Expansion System is
10.64.19.66. Other parameters on this screen may be set according to customer requirements.

Configuration | System = 1P500 Expansion v
S0OTP o s AN v Drecos, Senv e 1 F ey WM W WP Seastty  Costact Contes

Select the Vol P tab as shown in the following screen. If desired, the RTP Port Number
Range can be customized to a specific range of receive ports for the RTP media paths from
Primary server to the Expansion System. The defaults are used here.

System || IP500 Expansion v

weven LANT  LAND  DNS voicemad  Tolephony Diectony Servces  System fyeres SMTS  SMOR WM Vo Volb Securty. Coreact Center
“ P Eepanoon
LAN Settings  VoiP Network Tepddogy

Port Numbet Range

Mneum 46750 = Mawrream

Port Number fangs (NAT

Masum &7 = M rrvam

Lnabie KICP Monacnng on Port 4003
RTCP colloctsr B addyens fie phunes

Keepakves
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6.3. IP Route

In the sample configuration, the Expansion System LANL1 port is physically connected to the
local area network switch at the IP Office customer site. The default gateway for this network

is 10.64.19.1.

0000

6.4. IP Office Line

The IP Office Lines are automatically created on each server when a Secondary server or
Expansion System is added to the solution. Below is the IP Office Line to the Primary server.

o

Shon Cocec Vol Setege TI2 P

Wettoout Diwe

Addeu

x

In the reference configuration, a fax machine is connected to one of the analog ports on the
Expansion System. To accommodate T.38 fax, select the VolP Settings tab and configure the

following:
e Fax Transport Support: T38

1P Offics Line - Line 17

1=

Sarvm ae Sprtern (Doutbest
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Select the T38 Fax tab and enter the following:

Unselect the Use Default VValues option.
Set the T38 Fax Version option to 0 (zero). This matches the version AT&T uses.

e Verify that Disable T30 ECM is not checked,
Default values are used for the remaining fields. Select Ok (not shown).

Line A[E P Oice Line - Line 17

6.5. Saving Configuration Changes to Avaya IP Office
Similar to Section 5.9, navigate to File = Save Configuration in the menu bar at the top of

the screen to save the configuration performed in the preceding sections.

%" Send Multiple Configurations — O *
Select ] Change . Incoming Outgeing Error
IP Office Made RebootTime Call Barring Call Barring Status Progress
» IPOSE-Primary | Merge v 10:17 AM O 0 D | 0%
~ 10:17 AM | ] | 0%

IP500 Expansion | Merge

The active configuration may be saved to a file at any time by selecting File = Save

Configuration As.

Solution & Interoperability Test Lab Application Notes 43 of 49
IPO10TF

DDT; Reviewed:
SPOC 10/11/2016 ©2016 Avaya Inc. All Rights Reserved.



7. AT&T IP Toll Free Service Configuration

AT&T provides the IPTF service border element IP address, the access DID numbers, and the
associated DNIS digits used in the reference configuration. In addition the AT&T IPTF
features, and their associated access numbers, are also assigned by AT&T. AT&T requires
that the Avaya IP Office public (LANZ2) IP address be provided to the IPTF service, as part of
the provisioning process.

8. Verification Steps

The following procedures may be used to verify the Avaya IP Office R10 with the AT&T IP
Toll Free service configuration.

8.1. AT&T IP Toll Free Service

The following scenarios may be executed to verify Avaya IP Office R10 functionality with
the AT&T IPTF service:
e Place inbound calls, answer the calls, and verify that two-way talk path exists. Verify
that the calls remain stable for several minutes and disconnects properly.
e Incoming calls using the G.729A and G.711 ULAW codecs.
e Verify basic call functions such as hold, transfer, and conference.
e Place an inbound call to a telephone, but do not answer the call. Verify that the call
covers to voicemail (e.g., Voicemail Pro). Retrieve the message either locally or from
PSTN.
e Using the appropriate IPTF access numbers and codes, verify the “Legacy Transfer
Connect” DTMF initiated features.
e Inbound fax using T.38 or G.711.
e SIP OPTIONS monitoring of the health of the SIP trunk.
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8.2. Avaya IP Office 10
The following items may be used to analyze/troubleshoot Avaya IP Office operations.
8.2.1. System Status Application

The System Status application can be used to monitor or troubleshoot Avaya IP Office. The
System Status application can typically be accessed from Start = Programs = Avaya IP
Office = System Status. The following screen shows an example Logon screen. Enter the
Avaya IP Office IP address in the Control Unit IP Address field, and enter an appropriate
User Name and Password. Click Logon.

Online | Offine

n
' Logon

oGCT LN TS GG LTS 10.64.19.170

Services Base TCP Port: EWELE

U BT 2dministrator

Password:

Auto reconnect

Secure connection

After logging in, select Trunks - Line: 2 from the left navigation menu. (SIP Line 2 is
configured in Section 5.4). A screen such as the one shown below is displayed. In the lower
left, the Trace All button may be pressed to display tracing information as calls are made
using this SIP Line. The Ping button can be used to ping the other end of the SIP trunk (e.g.,

the AT&T Border Element, however the AT&T Border Element may not be configured to
respond to pings).

IP Office System Status

Furce Out of Seroce et
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By navigating to IP Networking = IP Routes, and clicking on Ping, an IP Office Source
Interface, and any Destination IP Address, may be specified for a ping by clicking OK.

L+ cemail
B IP Networking

(3P Routes

SSL VPN

Locations

Destination Subnet Mask Mext Hop IP

2 Ping from Interface X LA

Source Interface:

Destination IP Address:

Cancel

8.2.2. System Monitor Application

The System Monitor application can also be used to monitor or troubleshoot Avaya IP Office
functionality (see reference [3]). The System Monitor application can typically be accessed
from Start - Programs -> Avaya IP Office > Monitor.

File Edit ‘iew Filkers Status Help

(e 8|7 x|i] & le/m

The Monitor will be active at startup. To pause the Monitor, press the Pause M button.

The pause button will be replaced with the Start IT button. Press this button to resume the

monitoring. To clear the Monitor display, press the Clear X[ button. Below is a sample of a
monitored inbound call.
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The displayed data may be customized. Select the Options button ﬂ or select Filters >
Trace Options. The following screen shows the SIP tab, allowing configuration of SIP
monitoring. In this example, only the SIP Rx and SIP Tx boxes are selected.

9. Conclusion

As illustrated in these Application Notes, Avaya IP Office R10 can be configured to
interoperate successfully with the AT&T IP Toll Free service using AVPN or MIS/PNT
transport connections, utilizing service features listed in Section 2.1, and within the
limitations described in Section 2.2.

The reference configuration shown in these Application Notes is representative of a basic
enterprise customer configuration and is intended to provide configuration guidance to
supplement other Avaya product documentation. It is based upon formal interoperability
compliance testing as part of the Avaya DevConnect Service Provider program.
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